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Introduction
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1 IntroductionThis course guide accompanies the Level 2 training
sessions in Rhinoceros. This course is geared toindividuals who
will be using and/or supporting Rhino.

The course explores advanced techniques in modeling to help
participants better understand how to applyRhinos modeling tools in
practical situations.

In class, you will receive information at an accelerated pace.
For best results, practice at a Rhino

workstation between class sessions, and consult your Rhino
reference manual for additional information.

Duration:3 days

Prerequisites:

Completionof Level I training, plus three months experience
using Rhino.
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Course Objectives

In Level 2, you learn how to:

Customize toolbars and workspaces

Create simple macros

Use advanced object snaps

Use distance and angle constraints with object snaps

Construct and modify curves that will be used in surface
building using control point editingmethods

Evaluate curves using the curvature graph Use a range of
strategies to build surfaces

Rebuild surfaces and curves

Control surface curvature continuity

Create, manipulate, save and restore custom construction
planes

Create surfaces and features using custom construction
planes

Group objects

Visualize, evaluate, and analyze models utilizing shading
features

Place text around an object or on a surface

Map planar curves to a surface

Create 3D models from 2D drawings and scanned images

Clean up imported files and export clean files

Use rendering tools
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Exercise 1Trackball Mouse (Warm-up)

1 Begin a new model, save as Trackball.3dm.

2 Model a trackball mouse on your own.
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Part Two:

Advanced Modeling Techniques
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2 Customizing Workspaces, Toolbars, andButtonsThe Toolbar
Layout

The toolbar layout is the arrangement of toolbars containing
command buttons on the screen. The toolbarlayout is stored in a
workspace (.ws) file that you can open and save. Rhino comes with a
default

workspace and automatically saves the active toolbar layout
before closing unless the .ws file is read-only.You can create your
own custom workspaces and save them for later use.

New in version 2.0 is the ability to have more than one
workspace open at a time. This allows greaterflexibility to display
toolbars for particular tasks.

Rhinos workspace customization tools make it easy to create and
modify toolbars and buttons. Adding to

the flexibility is the ability to combine commands into macros
to accomplish more complex tasks. Inaddition to toolbar
customization, it is possible to set up command aliases and
shortcut keys to accomplishtasks in Rhino.


	
7/21/2019 Rhino Level 2 Training.pdf

14/198

C U S T O M I Z I N G W O R K S P A C E S , T O O L B A R S , A
N D B U T T O N S

Notes:

Robert McNeel & Associates 10

Exercise 2 - Customizing Rhinos interface

In this exercise we will create buttons, toolbars, macros,
aliases, and shortcut keys that will be availableto use throughout
the class.

To create a custom workspace:

1 Openthe ZoomLights.3dm model.

2 From the Toolsmenu, click Toolbar Layout.

3 From the Toolbarsdialog box File menu, click Save As.

4 Type Level 2 Trainingin the File namebox, and click OK.

A copy of the current default workspace has been saved under the
new name. Workspaces are savedwith a .ws extension. You will use
this new workspace to do some customization.

In the Toolbarsdialog box all the open workspaces are listed
along with a list of all the individualtoolbars for the selected
workspace. Check boxes show the current state of the toolbars. A
checkedbox indicates that the toolbar is displayed.

Edit Toolbar Layout

Look for this button.
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To create a new toolbar:

1 From the Toolbarsdialog box Toolbar menu, click New.

2 In the Toolbars Propertiesdialog box, name the toolbar Zoom,
and click Ok.

A new single-button toolbar appears on the screen.

3 Exit the dialog box.

A new toolbar can also be made by accessing the right click
popup menu in the title bar of an opentoolbar.

To edit the new button:

1 Hold down the Shift key and right-click the blank button in
the new toolbar.

The Edit Toolbar Buttondialog box appears with fields for
commands for the left and right mouse

buttons, as well as for the tooltip.2 In the Edit Toolbar
Buttondialog box, in the Tooltipbox, type Zoom Extents except
lights |

Zoom Extents except lights all viewports.

The vertical bar character (Shift+ \ key) is recognized as a
separator character for left and righttooltip.
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3 In the Edit Toolbar Buttondialog box, in the Left Button
Commandbox, type ! None SelLights

Invert ZoomSelected None.

4 In the Edit Toolbar Buttondialog box, in the Right Button
Commandbox, type ! None SelLights

Invert ZoomSelectedAll None.

5 Click Edit Bitmap.

The bitmap editor is a simple paint program that allows editing
of the icon bitmap. It includes a grab

function for capturing icon sized pieces of the screen, and an
import file function.If the bitmap is too large, only a portion of
the center is imported.

6 From the Filemenu, click Import Bitmap, and select the
ZoomNoLights.bmp.

You can import any bitmap image of the correct pixel dimensions
allowing you to make renderedbutton icons.

7 In the Edit Bitmapdialog box, make any changes to the picture,
and click OK.

To access the new button, click it in the Zoom Toolbar or you
can link the Zoom toolbar from anexisting button in another
toolbar.
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8 Use the button to zoom the model two ways.

You will notice that it ignores the lights when doing a zoom
extents.

You can enter the commands or command combinations in the
appropriate boxes, using these rules:

A space is interpreted as Enter. Commands do not have spaces
(e.g. ZoomExtentsAll) but you mustleave a space between
commands

If your command string refers to a file, toolbar, layer, object
name, or directory for which the pathincludes spaces, the path,
toolbar name, or directory location must be enclosed in
double-quotes.

A !followed by a space is interpreted as Cancel. Generally it is
best to begin a button command

with !if you want to cancel any other command which may be
running when you click the button.

View manipulation commands like Zoom, ZoomTarget, etc., can be
run in the middle of othercommands. For example, you can zoom and
pan while picking curves for a Loft. Placing the !infront of these
commands would not be appropriate.

User input and screen picks are allowed in a macro by putting
the Pause command in the macro.

Commands that have dialog boxes, such as Revolve, do not accept
input to the dialog boxes frommacros.

Note: The rules above also apply to scripts run from Read
Command File and Paste. More sophisticated

scripting is possible with the Rhino Script plug-in, but quite a
lot can be done with the basiccommands and macro rules. Some useful
commands to remember are: SelLast, SelPrev,SetObjectName, SelName,
Group, SetGroupName, SelGroup, Invert, SelAll, SelNone,
LayerOn,

LayerOff, ReadCommandFile, and SetWorkingDirectory.
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To link a toolbar to a button:

1 Shift+right-click the Zoom Extentsbutton in the
Standardtoolbar. In the Linked toolbar,Namelist, select Zoomand
click OK.

Now the Zoom Extentsbutton has a small white triangle in the
lower right corner indicating it has alinked toolbar.

2 Click and hold the ZoomExtentsbutton to fly out your newly
created single button toolbar.

If you click the X on the Zoomtoolbar you just created and close
it, you can always open it using theflyout button.

3 Try the new linked button.

To copy a button from one toolbar to another:

1 Hold the Ctrlkey and move your mouse to the button on the far
right of the Standardtoolbar.

The tooltip indicates that left click and drag will copythe
button and right click and drag will linkthe

button.

Zoom Extents

Look for this button.
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2 Copythe button one space over in the same toolbar. In the OK
to duplicate buttondialog box, click

OK.

3 Hold down the Shiftkey and right-click on the button you
copied to edit the button.

4 In the Linkedtoolbar dropdown choose Main.

5 Delete all the text in the boxes for both left and right mouse
button commands.

6 Type MainToolbarin the Tooltipline.

7 In the Edit Bitmapdialog box, clear the image, then make a
simple icon like the example below.

8 Close all the dialog boxes and return to the Rhino window.

9 Undock the Maintoolbar and close it.

10 Click on the new button that you just made.

The Maintoolbar flies out instantly and is available. This
allows the viewports to be larger than whenthe Main toolbar was
docked on the side.

11 Flyout the Maintoolbar and tear it off, so it is displayed
(floating).

To add a command to an existing button:

1 Hold the Shiftkey and right click the Copybutton on the
Maintoolbar.

2 In the Edit Toolbar Buttondialog box, in the Right Button
Commandbox, type ! Copy PauseInPlace. Copy

Look for this button.
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3 In the Edit Toolbar Buttondialog box, in the Tooltipbox, type
| Duplicate.

This button will allow you to duplicate objects in the same
location. We will use this command several

times during the class.

4 Select one of the objects in the model and right click on the
Copybutton.

5 Movethe selected object so that you can see the duplicate.

Command aliases

The same commands and macros that are available for buttons are
also available for command aliases.Command aliases are useful
productivity features in Rhino. They are commands and macros which
areactivated by a key or keys on the keyboard followed by
Enter,Spacebar or Right Mouse Button.

To make a command alias:

1 From the Toolsmenu, click Options.
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2 In the Options dialog box, on the Aliases tab, add aliases and
command strings or macros.

The alias is in the left column and the command string or macro
is in the right column. The same rules

apply here as with the buttons. Aliases can be used within other
aliases' macros or button macros.

3 Click Newto make a new alias.

We will make aliases to mirror selected objects vertically and
horizontally across the origin of theactive construction plane.
These are handy when making symmetrical objects built centered on
theorigin.

4 Type mvin aliascolumn. Type Mirror pause 0 1,0,0in the command
string column.

5 Click Newto make another new alias.

6 Type mhin aliascolumn. Type Mirror pause 0 0,1,0 in the
command string column.

7 Select some geometry and try the new aliases out. Type mhor
mvand press Enter.

If no objects are pre-selected, the Pausein the script prompts
you to select objects, and a secondEnterwill complete the selection
set.

When making aliases, usekeys that are close to eachother or
repeat the samecharacter 2 or 3 times, so theywill be easy to
use.
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To import command aliases:

1 From the Toolsmenu, click Commands, then click Import Command
Aliases.

2 In the ImportCommandAliasesdialog box, select Aliases.txt.The
alias text file contains alias definitions.

3 Open the Optionsdialog box to see the new aliases.

Shortcut keys

The same commands, command strings, and macros that you can use
for buttons are also available for

keyboard shortcuts. Shortcuts are commands and macros that are
activated by a function key, Ctrl and afunction key, or Ctrl and an
alphanumeric key on the keyboard.

To make a shortcut key:

1 From the Toolsmenu, click Options.

2 In theOptions dialog box, on the Keyboard tab, you can add
command strings or macros.

There are several shortcut keys that already have commands
assigned. The same rules apply here aswith the buttons.

3 Click in the column next to the F3to make a new shortcut.

4 Type DisableOsnapfor the shortcut.This shortcut will make it
easy to disable the running osnaps.

5 Exit the dialog box and try it out.
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Plug-ins

Plug-ins are programs that extend the functionality of
Rhino.

Several plug-ins are included with Rhino. Many others are
available for download from the Rhino website.

To load a plug-in:

1 Type LoadPlugin on the command line, and press Enter.

2 In the Rhino Plug-in File dialog box, change to the
Rhinoceros/Plug-insfolder and open

QLayeru.rhp.

This plug-in allows you to change the layer states from a
modeless dialog box.

3 Type Qlayer.This dialog box stays on until closed. It has
controls to turn layers on and off, to lock or unlock them,

to change the color, and make a layer current.

4 Close the dialog box.

To apply the plug-in command to a button:

1 Hold down the Shift+Ctrl key and click on the Edit
Layersbutton.

2 On the tooltip line add| Quick Layers

3 In the Right mouse button commandbox, type ! Qlayer, then
click OK.

4 Right click on theEdit Layersbutton to display the Qlayer
window.
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Scripting

Rhinoceros supports scripting using VBScript and JScript.

To script Rhino, you must have some programming skills.
Fortunately, VBScript and JScript are simpler toprogram than many
other languages, and there are materials available to help you get
started. VBScript

and JScript are programming languages developed and supported by
Microsoft.

We will not cover how to write a script in this class, but we
will learn how to run a script and apply it to a

button.

The following script will make a copy of an object and allow you
to place it on another layer in oneoperation.

To load a script:

1 On the command line, type LoadScriptand press Enter.

2 In the Load RhinoScriptdialog box, click Add.

3 In the Opendialog box, select CopyObjectsToLayer.rvb, then
click Open.

4 In the Load RhinoScriptdialog box, highlight
CopyObjectsToLayer.rvb, then click Load.

5 At the Select Objectsprompt, pick the cylinder, and press
Enter.
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6 In the Copy Objects to Layerdialog box, click Layer 01and then
click OK.

To edit the script file:

1 On the command line, type LoadScriptand press Enter.

2 In the Load RhinoScript dialog box, highlight
CopyObjectsToLayer.rvb, then click Edit.

The last line of the script, runs the script. Since we are going
to make a button to run the script after itis loaded, you can
delete this line.

3 Delete the last line in the script, then exit the editor and
save the changes.

4 Exit the Load RhinoScriptdialog box.

To make a button that will load or run a script:

1 From the Toolsmenu, click Toolbar Layout.

2 In the Toolbarsdialog box, check Layerand highlight it.

3 In the Toolbarsdialog box, from the Toolbarmenu, click Add
Button, then exit the Toolbarsdialogbox.

4 To edit the new button, hold down the Shiftkey and right click
on the new button.

5 In the Edit Toolbar Button dialog box, in the Tooltip, type
Copy Objects to Layer | Load CopyObjects to Layer Script.

6 In the Left Button Command box, type ! RunScript /rvb
/CopyObjectsToLayer.

7 In the Right Button Commandbox, type ! LoadScript
/CopyObjectsToLayer.rvb.

8 In the Edit Toolbar Buttondialog box, click Edit Bitmap.

9 In the Edit Bitmapdialog box, from the Filemenu, click Import,
and Openthe

CopyObjectsToLayer.bmp, then click OK.

10 In the Edit Toolbar Buttondialog box, click OK.
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11 Try the new button.

Template files

A template is a Rhino model file you can use to store basic
settings. Templates include all the informationthat is stored in a
Rhino 3DM file: objects, grid settings, viewport layout, layers,
units, tolerances, render

settings, dimension settings, notes, etc.

You can use the default templates that are installed with Rhino
or save your own templates to base futuremodels on. You will likely
want to have templates with specific characteristics needed for
particular types

of model building.

The standard templates that come with Rhino have different
viewport layouts or unit settings, but no

geometry, and default settings for everything else. Different
projects may require other settings to bechanged. You can have
templates with different settings for render meshes, angle
tolerance, namedlayers, lights, and standard pre-built
geometry.

The Newcommand begins a new model with a template (optional). It
will use the default template unlessyou change it to one of the
other templates or to any other Rhino model file.

The SaveAsTemplatecommand creates a new template file.

To change the template that opens by default when Rhino starts
up, choose Newand select the templatefile you would like to have
start when Rhino starts, then check the Use this file when Rhino
starts box.

To create a template:

1 Start a newmodel.

2 Select the Inches.3dmfile as the template.

3 From the Filemenu, click Properties.

4 From the Rendermenu, click Current Renderer, then click
Flamingo Raytrace.


	
7/21/2019 Rhino Level 2 Training.pdf

27/198

C U S T O M I Z I N G W O R K S P A C E S , T O O L B A R S , A
N D B U T T O N S

Notes:

Robert McNeel & Associates 23

5 In the Document Properties dialog box, on the Grid tab, change
the Snap spacingto .1, the Grid

spacingto 1, the Major grid linesto 10, and the Grid extentsto
10.

6 On the Render Meshtab change the setting to Smooth and
slower.
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7 On the Flamingotab click Environment,check Ground planeand
accept the default material.

8 On the Maintab check Background image.

9 On the Background imagetab, select JeffsSunroom.bmpfor the
background, under theProjectiondropdown select Spherical. Click
OKto exit the Environmentdialog box. Click OKtoexit the Document
Propertiesdialog box.

10 With the Perspectiveviewport active, type Gridand press
Enterto toggle the grid off.

11 Open the Layersdialog box and rename Layer 05to Lights, Layer
04to Curves, and Layer 03toSurfaces. Make the Lightslayer current.
Delete Default, Layer 01and Layer 02layers.Exit the

dialog box.


	
7/21/2019 Rhino Level 2 Training.pdf

29/198

C U S T O M I Z I N G W O R K S P A C E S , T O O L B A R S , A
N D B U T T O N S

Notes:

Robert McNeel & Associates 25

12 Set up two spotlights so that they point at the origin and
are approximately 45 degrees from the

center and tilted 45 degrees from the construction plane.

13 From the Rendermenu, click Current Renderer, then click
Rhino.

14 From the Rendermenu, click Properties.

15 On the Rhino Rendertab, check Use lights on layers that are
off, then click OK.

16 From the Rendermenu, click Current Renderer, then click
Flamingo Raytrace.

17 From the Editmenu, click Layers, then click One Layer Onto
make the Curveslayer the only visible

layer.

18 From the Filemenu, click Save As Templateand navigate to the
templates directory. Name thetemplate
Inches_SmallProduct_001.3dm.

This file with all of its settings is now available any time you
start a new model. You should makecustom templates for the kind of
modeling that you do regularly to save set up time.

One Layer ON

Look for this button.
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3 NURBS TopologyBasic NURBS Topology

NURBS Surfaces always have a rectangular topology. Surface
points and parameterization are organizedin two directions,
basically at right angles to each other. This is not always obvious
when creating or

manipulating a surface. Remembering this structure is useful in
deciding which strategies to use whencreating or editing
geometry.

Exercise 3 - Topology

This exercise will demonstrate how NURBS topology is organized
and discuss some special cases thatneed to be considered when
creating or editing geometry.

1 Openthe Topology.3dmmodel.

There are several surfaces and curves visible on the current
layer.

2 Turn on the control pointsof the simple rectangular plane on
the left.

It has four control points, one at each cornerthis is a simple
untrimmed planar surface that showsthe rectangular topology.

3 Now turn on the control pointsof the second, more curvy
surface.

There are many more points, but it is clear that they are
arranged in a rectangular fashion.

4 Now select the cylinder.

It appears as a continuous surface, but it also has a
rectangular boundary.

Control Points On

Look for this button.

N U R B S T O P O L O G Y
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5 From the Analyzemenu, click Edge Tools, then click Show
Edges.

Notice that there is a seam highlighted on the cylinder. The
seam (1) that is highlighted represents

two edges of the rectangle, while the other two edges (2 and 3)
are at the top and the bottom. Therectangular topology is present
here, also.

6 Now select the sphere.

It appears as a closed continuous object, but it also has a
rectangular boundary.

7 Use Show Edgesto show the edges.

Notice that there is a seam highlighted on the sphere. The seam
(1) that is highlighted represents twoedges of the rectangle, while
the other two edges are collapsed to a single point at the poles (2
and3). The rectangular topology is present here, also, though very
distorted.

8 With the sphere selected, press F11followed by F10. The
control points of the first two surfaces

have been turned off (F11) and those of the sphere have been
turned on (F10).

9 With the Point Osnapon, Zoom Targetvery tight in to one of the
poles of the sphere.

Show Edges

Look for this button.

Zoom Target(right mouse button option)

Look for this button.

N U R B S T O P O L O G Y
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10 Select the single point at the pole

11 From the Transformmenu, click Smooth, then click OK.

The single point has loosened into a tiny ring of points.

ShowEdgeswill highlight this as an edge as well. When all of the
points of an untrimmed edge are

collapsed into a single point, it is called a singularity.

A singularity is a special case, but as a general rule it is
better not to stack one control point on top ofanother. If internal
points of an edge are collapsed or stacked into a single point,
Rhino gives an errormessage in Checkor Select Bad Objects.

12 Use the Homekey to Zoomback out.This is the fastest way to
step back through views.

13 Next select the triangular surface.

Notice that it doesnt appear to be rectangular. It has
rectangular topology, but it has a singularity atone of the
vertices.

14 Turn on the control points.

15 Zoom to the vertex furthest to the right.

16 Select the point at the vertex.17 Use Smoothin the Y
direction.

Notice that the end gets flat and more points are visible.

Smooth

Look for this button.

N U R B S T O P O L O G Y
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To select points:

1 Open the Select Points toolbar.

2 Select a single point at random on the sphere.

3 Pick Select Uin the toolbar.

An entire row of points is selected.

4 Select none by clicking in an empty area and select another
point on the sphere.5 Pick Select Vfrom the toolbar.

A row of points in the other direction of the rectangle is
selected. This arrangement into U and V

directions is always the case in NURBS surfaces.

6 Try the other buttons in this toolbar on your own.

Exercise 4Trimmed NURBS

1 Openthe Trimmed NURBS.3dmmodel.

This surface has been trimmed out of a much larger surface. The
underlying four sided surface data isstill available after a
surface has been trimmed, but it is blocked by the trim curves on
the surface.

2 Select the surface and turn on the control points.

Control points can be manipulated on the trimmed part of the
surface or the rest of the surface, but

notice that the trimmed edges also move around as the underlying
surface changes. The trim curvealways stays on the surface.

Select U

Look for this button.

Select V

Look for this button.

N U R B S T O P O L O G Y
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To untrim a surface:

1 From the Surfacemenu, click Edit Tools, then click Untrim.

2 At the Select boundary to detachprompt, select the edge of the
surface.

The original underlying surface appears and the trim curves
disappear.

3 Undoto return to the previous trimmed surface.

To detach a trimming curve from a surface:

1 From the Surfacemenu, click Edit Tools, then click Detach
Trim.

2 At the Select boundary to detachprompt, select the edge of the
surface.The original underlying surface appears leaving the trim
curves. The trimming curves are in placealthough they are no longer
associated with the surface.

3 Undoto return to the previous trimmed surface.

Untrim

Look for this button.

Detach Trim

Look for this button.

Undo

Look for this button.

N U R B S T O P O L O G Y
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To shrink a trimmed surface:

1 From the Surfacemenu, click Edit Tools, then click Shrink
Trimmed Surface.

2 At the Select trimmed surfaces to shrinkprompt, select the
surface and press Enterto end thecommand.

The underlying untrimmed surface is replaced by a one with a
smaller range that matches the oldsurface exactly in that range.
You will see no visible change in the trimmed surface. Only the

underlying untrimmed surface is altered.

Shrink Trimmed Surface

Look for this button.

C U R V E C R E A T I O N
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4 Curve CreationWe will begin this part of the course by
reviewing a few concepts and techniques related to NURBS curvesthat
will simplify the learning process during the rest of the class.
Curve building techniques have asignificant effect on the surfaces
that you build from them.

Curve Degree

The degree of a curve is related to the extend of the influence
a single control point has over the length of

the curve.

For higher degree curves, the influence of any single point is
less in a specific part of the curve but has a

greater effect over a longer portion of the curve. For that
reason, continuity is greater for higher degreecurves.

In the example below, the five curves have their control points
at the same six points. Each curve has a

different degree. The degree can be set with the (Degree=)
option in the Curve command.

Exercise 5Curve Degree

1 Open the Curve Degree.3dmmodel.

C U R V E C R E A T I O N
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2 Use the Curvecommand with Degreeset to1, using the PointOsnap
to snap to each of the points.

3 Use the Curvecommand with Degreeset to2, using the PointOsnap
to snap to each of the points.

4 Use the Curvecommand with Degreeset to3, using the PointOsnap
to snap to each of the points.

CurveLook for this button.

C U R V E C R E A T I O N
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5 Use the Curvecommand with Degreeset to4, using the PointOsnap
to snap to each of the points.

6 Use the Curvecommand with Degreeset to5, using the PointOsnap
to snap to each of the points.
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Curve and surface continuity

Since creating a good surface so often depends upon the quality
of the input curves, it is worthwhile

investigating some of the characteristics of both.

Curves

For most curve building and surface building purposes we can
talk about four useful levels of continuity:

Not continuous- the curves or surfaces do not meet at their end
points or edges

Positional continuity- curves meet at their end points, surfaces
meet at their edges (G0)

C U R V E C R E A T I O N

Notes:
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Tangency continuity- curves or surfaces meet and the directions
of the tangents at the endpoints or

edges is the same (G1). You should not see a crease or a sharp
edge.

Curvature continuity- curves or surfaces meet, their tangent
directions are the same and the radiusof curvature is the same for
each at the end point (G2)

C U R V E C R E A T I O N

Notes:
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What does this means to the modeler?

The first case, where there is no continuity is self
explanatory, the objects cannot be joined.

Positionalcontinuity (G0) means that there is a kink at the
point where two curves meet. The curves can

be joined in Rhino into a single curve but there will be a kink
and the curve can still be exploded into atleast two subcurves.
Similarly two surfaces may meet along a common edge but will show a
kink or seam,a hard line between the surfaces. For practical
purposes, only the end points of a curve or the last row ofpoints
along an edge of an untrimmed surface are taken into account in G0
continuity.

Tangencycontinuity (G1) means that there is no kink between
curves or surfaces but rather a smoothertransition. The clearest
example of G1 continuity is a radial fillet between curves or
surfaces. In tangency

continuity the end point and the next point on a curve, or the
edge row and the next row of points of asurface determine the
tangency conditions.

Curvaturecontinuity (G2) is the smoothest of the cases we are
considering. It means that the surface or

curve changes more smoothly than with tangency continuity. There
is no clear point of change from onecurvature to the next. In G1
continuity the curvature changes at a single point. For example,
thetransition from a straight line to a tangent arc takes place at
a given point. With G2 continuity this change

happens over a distance in the curves, so that curves and
surfaces tend to have a more smooth (organic)and less mechanical
look to them. Many product designs make use of G2 continuity.

Note: There are higher levels of continuity possible. For
example, G3 continuity means that not only are

the conditions for G2 continuity met, but also that the rate of
change of the curvature is the sameon both curves or surfaces at
the common end points or edges.G4 means that the rate of change
of

the rate of change is the same. Rhino has tools to build such
curves and surfaces, but fewer toolsfor checking and verifying such
continuity than for G0-G2.

Exercise 6 - Geometric Continuity

1 Open the Curve Continuity.3dmmodel.

The two curves are clearly not tangent. Verify this with the
continuity checking command GCon.

2 From the Analyzemenu, click Curve, then click Geometric
Continuity.

Geometric Continuity

Look for this button.

C U R V E C R E A T I O N

Notes:
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3 Click near the common ends (1and 2) of each curve.

Rhino prints a message on the command line indicating the curves
are not touching at the ends.

Ends of curves are 0.0304413 units apart - no geometric
continuity.

To make the curves have position continuity:

1 Turn on the control points for both curves and zoom in to the
common ends.

2 Turn on the Pointosnap and drag one of the end points onto the
other.

3 Repeat the Geometric Continuitycommand.

The command line message indicates:

Endpoints touch.Tangents differ by 10.3069 degrees.

Geometric continuity = G0

4 Undothe previous operation.

C U R V E C R E A T I O N

Notes:
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5 From the Curvemenu, click Edit Tools, then click Match.

6 At the Select curve to change - pick near end prompt, pick
near the common end of one of the

curves.

7 At the Select curve to match - pick near end
(SurfaceEdge)prompt, pick near the common endof the other
curve.

8 In the Match Curve dialog box, check Position, Average Curves,
and Preserve other end.

9 Repeat the Geometric Continuitycommand.

The command line message indicates:

Endpoints touch.

Tangents differ by 10.2784 degrees.Geometric continuity = G0

Exercise 7 - Tangent Continuity

In this part of the exercise, we will make the two curves have
G1 continuity. G1 continuity is determinedby the end points and the
second points of the curves. These two points determine the tangent
direction

of the end of a curve and since G1 continuity requires that the
tangent direction be the same for bothcurves, it is sufficient to
have the two last points on each curve, four all together, fall in
line with eachother. The two end points must be in the same place
and the next control point on each curve must fall ina line with
those end points. This can be done by manipulating the points
directly or by using the Match

command.

We will use Move, SetPt, ZoomTarget, PtOn(F10), PtOff(F11) and
the osnaps End, Point, Along,Betweenand the Tab lockto accomplish
this.

First, we will create some aliases that will be used in this
exercise.

Match

Look for this button.

C U R V E C R E A T I O N
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To make Along and Between aliases:

Alongand Betweenare one-time object snaps that are available in
the Toolsmenu under Objectsnaps. They can only be used after a
command has been started and apply to one pick. We will create

aliases for these object snaps.

1 In the Options dialog box on the Aliasestab, type ain the
Alias column and Alongin the Command

string column.

2 Type bin the Aliascolumn, and Betweenin the Command string
column.

3 Close the Optionsdialog box.

To change the continuity by adjusting control points using the
between osnap:

1 Use OneLayerOnto turn on only the Curves 3d layer.

2 Check the continuity of the curves with the GCon command.

3 Turn on the Control pointsfor both curves.

4 Window select the common end points of both curves (1).

5 Use the Movecommand to move the points.

6 At the Point to move from (Vertical)prompt, snap to the same
point (1).

7 At the Point to move toprompt, type band press Enterto use the
Betweenosnap.

8 At the First pointprompt, select the second point (2) on one
curve.

AlongLook for this button.

Between

Look for this button.

One Layer ON

Look for this button.

Move

Look for this button.

C U R V E C R E A T I O N

Notes:
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9 At the Second pointprompt, select the second point (3) on the
other curve.

The common points are moved in between the two second points,
aligning the four points.

10 Check the continuity.

To change the continuity by adjusting control points using the
along osnap:

1 Undo the previous operation.

2 Select one of the second points (2 or 3).

3 Use the Movecommand to move the point.

4 At the Point to move from (Vertical)prompt, snap to the point
(2 or 3).

5 At the Point to move toprompt, type aand press Enterto use the
Alongosnap.

6 At the Start of tracking lineprompt, select the second point
(3 or 2) on the other curve.

C U R V E C R E A T I O N

Notes:7 A h E d f ki li h i (1)
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7 At the End of tracking lineprompt, snap to the common points
(1).

The point tracks along a line that goes through the two points,
aligning the four points. Click to placethe point.

8 Check the continuity.

G1 continuity can be maintained by making sure that any point
manipulation of the critical four pointstakes place along the line
on which they all fall.

Once you have G1 continuity you can still edit the curves near
their ends without losing continuity.

To edit the curves without losing continuity:

1 Select the end points or either of the second points on the
curves.

C U R V E C R E A T I O N

Notes:2 T n on the Point o n p onl nd d g (o Mo e) the point to
nothe of the fo t ngen point
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2 Turn on the Pointosnap only and drag (or Move) the point to
another of the four tangency points.

3 When the point is dragged or moved over the next point and the
osnap flag lights up, do not click themouse. Instead press and
release the tabkey and then continue dragging.

The movement of the point is now constrained to the line between
the original location and the pointin space where the tab key was
pressed ensuring that G1 continuity is maintained.

Pressing tabagain before finally placing the point will release
the Tabdirection lock, losing theguarantee of continuity.

4 Press the left mouse button to place the point.

Exercise 8 - Curvature Continuity

Curvature continuity (G2) is more complicated as it involves the
last three points on a curve. Theirarrangement is only in a
straight line like G1 continuity when the curve being matched is a
straight line or

has no curvature at the end.

Maintaining G2 continuity when directly manipulating points is
more complicated than it is for G1.

C U R V E C R E A T I O N

Notes:For establishing G2 continuity the Match command must be
used
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For establishing G2 continuity the Matchcommand must be
used.

To match the curves:

1 Turn on the 3D curvelayer and make it current.2 Turn off the
2D curvelayer.

3 Use the Matchcommand to matchthe magenta (1) curve to the red
(2) curve.

When you use Matchwith Curvaturechecked on these particular
curves, the third point on the curve

to be changed is constrained to a position calculated by Rhino
to establish the desired continuity.

The curve being changed is significantly altered in shape.
Moving the third point by hand will break the

G2 continuity at the ends, though G1 will be maintained.

C U R V E C R E A T I O N

Notes:

Advanced techniques for controlling continuity
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Advanced techniques for controlling continuity

There are two additional methods to edit curves while
maintaining continuity in Rhino. (1) The EndBulgecommand allows the
curve to be edited while maintaining continuity. (2) Adding knots
will allow more

flexibility when manipulating points.

To edit the curve with End Bulge

1 Use Dupto make a copy of the magenta curve and then
Lockit.

2 From the Curvemenu, click Edit Tools, the click Adjust End
Bulge.

3 At the Select curve to adjustprompt, select the red curve.

Note:Endbulgeconverts any curve that has fewer than six control
points to a degree 5 curve with sixcontrol points.

Adjust End Bulge

Look for this button.

C U R V E C R E A T I O N

Notes:4 At the Drag points to adjust end bulge
(PreserveCurvature=Yes) prompt, select the third point
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4 At the Drag points to adjust end bulge (PreserveCurvature
Yes)prompt, select the third point

and drag it, the press Enterto end the command.

The G2 continuity is preserved.

To add a knot:

Adding a knot or two to the curve will put more points near the
end so that the third point to be nearerthe end. Knots are added to
curves and surfaces with the InsertKnot command.

1 Undoyour previous adjustments.

2 From the Editmenu, click Point Editing, then click Insert
Knot.

Add a knot in between the first two points. Insert Knot

Look for this button.

C U R V E C R E A T I O N

Notes:3 Matchafter inserting a knot to the red curve.
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g

In general a better behaved curve will result if the new knots
are placed roughly halfway between

existing knots, which are highlighted during the
InsertKnotcommand.
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5 Surface ContinuitySurface Continuity

The continuity characteristics reviewed for curves can also be
also applied to surfaces. The difference isinstead of dealing with
the end point, second, and third points, entire rows of points at
the edge, and the

next two positions away from the edge are involved. The tools
for checking continuity between surfacesare different from the
simple GConcommand.

Rhino takes advantage of the OpenGL capability to create false
color displays used in checking curvatureand continuity within and
between surfaces. These tools are located in the Analyze menu,
under Surface.The tool which most directly measures G0-G2
continuity between surfaces is Zebra.

Note: An OpenGL is card is not necessary to use these tools,
although they may work faster with OpenGLacceleration.

S U R F A C E C O N T I N U I T Y

Notes:

Exercise 9 - Surface Continuity
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1 Open the file Surface Continuity.3dm.

2 Turn on points on both surfaces.

To check the continuity between the surfaces using Zebra:

1 From the Analyzemenu, click Surface, then click Zebra.

The surfaces are colored by stripes.

2 Exit Zebra.

3 From the Surfacemenu, click Edit Tools, then click Match.

4 At the Select surface to change - select near edgeprompt,
select the edge of the red surface

nearest the black surface.

5 At the Select target surface - select near edgeprompt, select
the edge of the black surfacenearest the red surface.

ZebraLook for this button.

Match Surface

Look for this button.

S U R F A C E C O N T I N U I T Y

Notes:6 In the Match Surfacedialog box, choose Positionas the
desired continuity. Make sure Averageis

unchecked and Preserve opposite end is checked then click OK
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unchecked and Preserve opposite endis checked, then click
OK.

The edge of the red surface is pulled over to match the edge of
the black one.

7 Jointhe surfaces.

8 Check the polysurface with Zebra.

There is no particular correlation between the stripes on one
surface and the other except that theytouch. This indicates G0
continuity.

S U R F A C E C O N T I N U I T Y

Notes:9 Explode the polysurface, and use the MatchSrfcommand
(Surface > Edit Tools > Match) again with

the Tangency option
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the Tangency option.

When you pick the edge to match you will get direction arrows
that indicate which surface edge isbeing selected. The surface that
the direction arrows are pointing toward is the surface
selected.

10 Jointhe surfaces and check the results with Zebra.

11 Adjust the controls in Zebra so that the stripes are thinner
and alternate the direction between verticaland horizontal to get
the most informative display.

This time there is a correlation between the surfaces. If the
stripes are chunky and angled over thesurface, use the Adjust mesh
button to make a finer mesh setting for the display. The ends of
the

stripes on each surface meet the ends on the other cleanly
though at an angle. This indicates G1continuity.

S U R F A C E C O N T I N U I T Y

Notes:12 Explode the polysurface, and use the MatchSrfcommand
(Surface > Edit Tools > Match) with the

Curvature option
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Curvatureoption.

13 Jointhe surfaces and check the results with Zebra.

The stripes now align themselves smoothly across the seam. Each
stripe connects smoothly to thecounterpart on the other surface.
This indicates Curvature (G2) continuity.

Note: Doing these operations one after the other may yield
different results than going straight to

Curvature without first using position. This is because each
operation changes the surface near theedge, so the next operation
has a different starting surface.

Anther method to control surface matching

As in matching curves, MatchSrfwill sometimes distort the
surfaces more than is acceptable in order toattain the desired
continuity. Knots can be added to surfaces to limit the influence
of the MatchSrf

operation. The new second and third rows of points are closer to
the edge of the surface.

S U R F A C E C O N T I N U I T Y

Notes:Surfaces can also be adjusted with the
EndBulgeSrfcommand.
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To add a knot to a surface:

1 Undothe previous operation.

2 Use InsertKnotto insert a row of knots at both ends of the red
surface.

When this command is used on a surface, it has more options. You
can choose to insert a row of knotsin the U direction, the V
directions, or both. Choose Symmetricalto add knots at both ends of
asurface.

3 Use MatchSrfto match the surfaces to the other.

To adjust the surface using EndBulge:

1 From the Surfacemenu, click Edit Tools, then click Adjust End
Bulge.

2 At the Select surface edge to editprompt, pick the edge of the
red surface.Adjust Surface End Bulge

Look for this button.

S U R F A C E C O N T I N U I T Y

Notes:3 At the Point to editprompt, pick a point on the edge at
which the actual adjustment will be

controlled.
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4 At the Start of region to edit. Press Enter to edit entire
rangeprompt, pick a point along thecommon edges to define the
region to be adjusted.

S U R F A C E C O N T I N U I T Y

Notes:5 At the End of region to edit. Press Enter to edit
remainder of rangeprompt, pick another point

to define the region to be adjusted.
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The influence of the adjustment will fade to zero at each end of
the region you define. Constructiongeometry may be useful here for
snapping an exact region if necessary. If the whole edge is to
beadjusted equally, simply press Enter.

Rhino shows three sets of points on each curve, of which you are
allowed to manipulate only two. Of

these two, notice that Rhino moves the point that is not being
directly manipulated in order tomaintain the continuity. If
maintaining the G2 curvature-matching condition at the edge is not
needed,typing in P and Enterat the PreserveCurvature option will
turn off one of the two points available for

editing and only G1 will be preserved.

6 At the Drag points to adjust end bulge ( PreserveCurvature=Yes
)prompt, drag some points.

S U R F A C E C O N T I N U I T Y

Notes:7 At the Drag points to adjust end bulge (
PreserveCurvature=Yes )prompt, press Enterto end

the command.
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Commands that use continuity

Rhino has several commands that pay attention to, or have the
option to pay attention to, input curves

which are surface edges. They can build the surfaces with G1 or
G2 continuity to those neighboringsurfaces. The commands are:

NetworkSrf

Sweep2

Patch (G1 only)

Loft (G1 only)

Blend (G1 or G2)

The following exercises will provide a quick overview of these
commands.

Exercise 10Continuity Commands

To create a surface from a network of curves:

1 Openthe Continuity Commands.3dm.

On the Surfaces layer there are two joined surfaces which have
been trimmed leaving a gap. This gapneeds to be closed up with
continuity to the surrounding surfaces.

S U R F A C E C O N T I N U I T Y

Notes:2 Turn on the Networklayer.

There are several curves already in place which define the
required cross sections of the surface.
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y p q

3 Use the NetworkSrfcommand (Surface > From Curve Network) to
close the hole with an untrimmed

surface using the curves and the edges of the surfaces as input
curves.

The NetworkSrfdialog box allows you to specify the desired
continuity on edge curves which havebeen selected.

Note that there is a maximum of four edge curves as input. You
can also specify the tolerances ormaximum deviation of the surface
from the input curves. By default the edge tolerances are the
sameas the file's Units tolerance. The interior curves are set 10
times looser than that by default.

Surface from Curve Network

Look for this button.

S U R F A C E C O N T I N U I T Y

Notes:4 Change the Interior Curvessettings to .01. Choose
Curvaturecontinuity for all the edges.

The surface that is created has curvature continuity on all four
edges.
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5 Check the resulting surface with the Zebracommand.

To make the surface with a 2 Rail Sweep:

1 Use OneLayerOnto open the Surfaceslayer by itself again and
then left click in the layers panel of

the status bar and select the Sweep2 layer.

S U R F A C E C O N T I N U I T Y

Notes:2 Start the Sweep2command (Surface > Sweep 2 Rails) and
select the long surface edges as the rails

(1 & 2).
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3 Select one short edge (1), the cross section curves (2, 3, 4,
5) and the other short edge (6) asprofiles.

Since the rails are surface edges the display calls them out as
edges 1 and 2, while the Sweep 2Rails Optionsdialog box gives the
option of maintaining continuity at these edges.

Sweep along 2 Rails

Look for this button.

S U R F A C E C O N T I N U I T Y

Notes:4 Choose to match edge curvature on both rails.
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5 Check the resulting untrimmed surface with Zebra.

To make surface with a Patch:

Patch builds a trimmed surface, if the bounding curves form a
closed loop, and can match continuity to G1if the bounding curves
are edges.

1 Turn on the Surfaces, and Patchlayers. Turn all other layers
off.2 Start the Patch command (Surface > Patch).

3 Select the edge curves and the interior curves, and then press
Enter.Patch

Look for this button.

S U R F A C E C O N T I N U I T Y

Notes:4 In the Patch Optionsdialog box, check Adjust tangencyand
Automatic trim, then click OK.

The finished surface does not appear to be very smooth. There
are a number of settings available for

adjusting the surface accuracy We will make some changes and
repeat the command
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adjusting the surface accuracy. We will make some changes and
repeat the command.

5 Undothe previous operation.

6 Use Patchand select the same edges and curves.

7 In the Patch Optionsdialog box, change the Sample point
spacingto .01and the Stiffnessto1.0, the Surface Uand Vspansto 17,
then click OK.

The finished surface appears smoother, but the isoparms are
oriented abnormally.

8 Undothe previous operation.

9 Turn on the Starting Surfacelayer.

10 Use Patchand select the same edges and curves.

11 In the Patch Optionsdialog box, click Starting surface.

S U R F A C E C O N T I N U I T Y

Notes:12 At the Select starting surfaceprompt, select the
rectangular surface (1).

Change the Starting Surface pullto 0.0.
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The surface is good and the isoparms are oriented better.

13 Jointhe surfaces.

S U R F A C E C O N T I N U I T Y

Notes:14 From the Analyzemenu, click Edge Tools, then click Show
Naked Edges.

There is a naked edge (1) between the patch and the polysurface.
You can join the naked edges for

meshing or rendering purposes
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meshing or rendering purposes.

15 Undo the Patch surface and remake it with more isoparms.

16 Continue to work with this until it joins without naked
edges.

17 Again, check the results with Zebra.

To make surface with Loft:

The next command which has built in options for surface
continuity is Loft.

1 Open the Loft and Blend.3dm.

Why cant I join the edges

using Join 2 Naked Edges?

S U R F A C E C O N T I N U I T Y

Notes:2 Start the Loftcommand (Surface > Loft).

3 At the Select curves to loft (Point)prompt, select the two
edge curves (1, 4) and the two curves

(2, 3). Loft
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( , 3)

4 Press Enterwhen done.

5 In the LoftOptionsdialog box, Select Normalfor Style, check
Match start tangent, Match endtangent, and Do not simplify.

The new surface has G1 continuity to the original surfaces.

Look for this button.

S U R F A C E C O N T I N U I T Y

Notes:To make a surface blend:

The last command that pays attention to continuity is
BlendSrf.
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1 Undothe loft.

2 Start the BlendSrf command (Surface > Blend), choose
continuity in the command line options.

3 Select an edges, and press Enter, then select the other edge
and press Enter.

The curve edges at each will get highlighted and the Blend
Bulgedialog box pops up.

There is an option to add more sections when the dialog box is
displayed.

4 Adjust the bulge if desired, then click OK.

5 Again, check the results with Zebra.

Blend SurfaceLook for this button.

S U R F A C E C O N T I N U I T Y

Notes:

Additional Surfacing Techniques

There are several methods for making surface transitions. In
this exercise we will discuss a variety ofways to fill holes and
make transitions using NetworkSrf, Loft, Sweep2, Blend and
Patch.
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ways to fill holes and make transitions using NetworkSrf, Loft,
Sweep2, Blendand Patch.

Fillets and Corners

While Rhino has automated functions for making fillets, there
are several situations that take manual

techniques. In this section, we will discuss making corners with
different fillet radii, variable radius filletsand blends, and
fillet transitions.

Exercise 11Fillets and Blends

To make a corner fillet with 3 different radii and a curve
network:

1 Openthe Corner Fillet.3dm.

2 Use the FilletEdgecommand (Solid > Fillet Edge) to fillet
edge (1) with a radius of 5, edge (2) with aradius of 3, and edge
(3) with a radius of 2.

Fillet Edge

Look for this button.

S U R F A C E C O N T I N U I T Y

Notes:3 Start the ExtractSrfcommand (Solid > Extract
Surface), then select the 3 fillets (1, 2, 4) and the

front surface (3), the press Enterto end the command.

Extract Surface
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4 Blendthe edge curves of the fillet surfaces (2 & 4).

5 Trimthe surfaces with the blend curves (1) and (2).

Look for this button.

S U R F A C E C O N T I N U I T Y

Notes:

Note: The blend curves will not actually touch the fillet
surface precisely. The blend curve is not an arc

like the fillet surface. You may have to pull the curve to the
surface before trimming or use theSplit command.


	
7/21/2019 Rhino Level 2 Training.pdf

75/198

Robert McNeel & Associates 71

6 Use theNetworkSrf command to fill the hole.

7 At the Select curves in network ( NoAutoSort )prompt, select
the edge curves.

8 At the Select curves in network ( NoAutoSort )prompt, press
Enter.

9 In the Surface From Curve Networkdialog box, select
Tangencyfor all four edges.

S U R F A C E C O N T I N U I T Y

Notes:To make a variable radius fillet:

1 Open the Sandal Sole.3dm.

2 Use the Circlecommand with the AroundCurve option to create
circles of different radius around the
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pbottom of the sole.

3 Use the SelLayer(Edit > Select > On Layer) command to
select the curve and the circles.

4 Start the Sweep1 command (Surface > Sweep 1 Rail) to make a
variable radius pipe around theedge.

5 In the Sweep 1 Rail Optionsdialog box, check Rebuild with 8
control pointsand Closed sweep,then press OK.

If you dont rebuild the surface, it can become quite complex.
Another option to simplify the sweptsurface is to align the seam to
the same knot point on each cross-section.

6 Unlock the Shoe Bottom layer.

Circle: Around Curve

Look for this button.

Select Layers

Look for this button.

Sweep along 1 Rail

Look for this button.

S U R F A C E C O N T I N U I T Y

Notes:7 Explodethe shoe polysurface.

8 While the three surfaces are still selectedSplitthe sidewall
(1) and the bottom (2) with the swept

surface.
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9 Turn off the CurveLayer and change to theFillet layer.

10 Delete the small part of the split surfaces to leave an empty
strip between the side and bottom of thesole.

Note:You may have to merge the edges (Analyze > Edge Tools
> Merge Edge) of the trimmed surfaces

before you blend. It helps to hide the other surfaces while you
merge the edges. Merge Edge

Look for this button.

S U R F A C E C O N T I N U I T Y

Notes:11 Use the BlendSrf command (Surface > Blend) to make
the variable fillet.

Blend Surface

Look for this button


	
7/21/2019 Rhino Level 2 Training.pdf

78/198

Robert McNeel & Associates 74

To make a six-way fillet using patch:

1 Openthe Fillet Edge.3dm.

2 Use the FilletEdgecommand, Radius=1, to fillet all the edges
at the same time.

Look for this button.

S U R F A C E C O N T I N U I T Y

Notes:3 Use the Patchcommand (Surface > Patch) to fill in the
opening at the center.

4 Select all six edges to define the patch.

Patch

L k f thi b tt
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5 In the Patch Optionsdialog box, check Adjust Tangencyand
Automatic Trim. Change theSurface Uand V Spansto 6.

Note:When the area to fill has more than four edges, Patchworks
better than NetworkSrf.

Look for this button.
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Notes:
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6 Advanced Surfacing TechniquesDome-shaped buttonsTo model a
product like a cell phone case, we need soft domed buttons: the
button edges have to conformto a compound-curved surface. In the
following exercise we will discuss several methods to make
dome-

shaped buttons.

Exercise 12Soft Domed Buttons

1 Openthe Button Domes.3dm.The key to this exercise is defining
a custom construction plane that represents the closest
planethrough the area of the surface that you want to match. Once
you get the construction plane

established, there is a variety of approaches available for
building the surface.

There are several ways to define a Cplane. In this exercise we
will discus three methods: CPlane

through 3 Points, CPlane Perpendicular to Curve, and
FitPlane.

2 Use OneLayerOnto turn on the Surfaces to Matchlayer to see the
surface that determines the cutof the button.

A D V A N C E D S U R F A C I N G T E C H N I Q U E S

Notes:To create a custom Cplane using 3 points method:

1 From the Viewmenu, click Set CPlane, then click 3 Points.

2 In the Perspectiveviewport, using the Nearosnap, pick three
points on the edge of the trimmedhole. Set CPlane: 3 Points
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hole.

The construction plane now goes through the three points.

3 Rotate the Perspectiveviewport to see the grid aligned with
the surface.

To create a custom CPlane using CPlane Perpendicular to
Curve:

With a surface Normaland CPlanePerpToCurveyou can define a
tangent construction plane at anygiven point on the surface.

1 From theView menu, clickSet Cplane, then clickPrevious.

Set CPlane: 3 Points

Look for this button.

Set CPlane: Previous

Look for this button.

A D V A N C E D S U R F A C I N G T E C H N I Q U E S

Notes:2 From the Curvemenu, click Line, then click Normal to
Surface.

3 Draw a normal on the surface at a point near the center of the
trimmed hole.

4 From the Viewmenu, click Set CPlane, then click Perpendicular
to Curve.

5 At the Select curve to orient CPlane to prompt, pick the
normal.Surface Normal
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5 At the Select curve to orient CPlane toprompt, pick the
normal.

6 At the CPlane originprompt, use the Endpoint osnap and pick
the end of the normal where itintersects the surface.

The CPlane is set perpendicular to the normal.

To create a custom CPlane using FitPlane and CPlane to
Object:

Using FitPlane through a sample of extracted point objects will
generate a plane that best fits the

points. CPlaneObject will then place a Cplane with its origin on
the center of the plane. This is a good

choice in the case of the button in this file. There are several
curves from which the points can beextracted the edge of the button
itself, or from the trimmed hole in the surrounding surface.

1 From theViewmenu, click Set Cplane, then click Previous.

2 Turn on the Surfaceslayer.

3 Use the DupEdgecommand (Curve > From Objects > Duplicate
Edge) to duplicate the top edge ofthe button.

Look for this button.

Set CPlane: Perpendicular to Curve

Look for this button.

Duplicate Edge

Look for this button.

A D V A N C E D S U R F A C I N G T E C H N I Q U E S

Notes:4 Copy the duplicated curve vertically twice. The vertical
position of these curves will determine the

shape of the curved edge of the button.
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5 Use the ExtractPt(Curve > From Objects > Extract Points)
command on the top curve.

Extract Points

Look for this button.

A D V A N C E D S U R F A C I N G T E C H N I Q U E S

Notes:6 Use the PlaneThroughPtcommand (Surface > Rectangle
> Through Points) with the extracted points

that are already selected, then hide the points.

A plane is fitted through the points.
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7 Use the CplaneObject command (View > Set Cplane > To
Object) to align the construction plane with

the plane.

8 From the Viewmenu, click Named Cplanes, then click Save to
save and name the customconstruction plane.

9 In the Name of Cplanedialog box, type Button Topand click
OK.

To loft the button:

1 Use Loftto make the button.

Set CPlane: To Object

Look for this button.

Save CPlaneLook for this button.

A D V A N C E D S U R F A C I N G T E C H N I Q U E S

Notes:2 At the Select curves to loft ( Point )prompt, type Pand
press Enter.

3 At the End of lofted surface prompt, type 0and press
Enter.

The loft is ended at a point in the middle of the plane, which
is the origin of the Cplane.

4 At the Matching seams and directions...Select seam point to
adjust. Press Enter when done
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(FlipDirection Automatic Natural)prompt, press Enter.

5 In the LoftOptionsdialog box, choose Loosefor Style.

With the Loose option, the control points of the input curves
become the control points of the resulting

surface, as opposed to the Normal option in which the lofted
surface is interpolated through thecurves.

6 Turn points on the lofted surface.7 Select the next ring of
points out from the center.

Select one point and use SelVor SelUto select the whole ring of
points.

A D V A N C E D S U R F A C I N G T E C H N I Q U E S

Notes:8 Use the SetPtcommand (Transform > Set Points) to set
the points to the same Z elevation as the

point in the center.

9 In the SetPointsdialog box, check the Zbox only and Align to
Cplaneoption.

10 At the Location of pointsprompt, type in 0and press
Enter.

Set Points

Look for this button.


	
7/21/2019 Rhino Level 2 Training.pdf

87/198

Robert McNeel & Associates 83

11 Use the SetCplaneTopcommand (View > Set Cplane > World
Top) to set the Cplane back to thedefault position.

Once the surface is made you can adjust it by selecting rings of
points with elevator mode, or inanother orthogonal view, move the
points up and down to alter the shape. Remember to move themiddle
point and the next ring of points together so they do not go out of
plane with one another.

To use Patch to make the button:

Another method to make a button is to use Patch.

1 Use theDupEdgecommand to duplicate the top edge of the
surface.

2 Movethe duplicated curve in the Z direction a small
amount.

Set Cplane: World Top

Look for this button.

A D V A N C E D S U R F A C I N G T E C H N I Q U E S

Notes:3 Use the ExtractPtcommand on the curve.

4 Use the PlaneThroughPtcommand with the extracted points that
are already selected, then hide the

points.

5 Use CplaneObjectto the plane.
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6 Make a circle or ellipse centered on the origin of the custom
construction plane.

A D V A N C E D S U R F A C I N G T E C H N I Q U E S

Notes:7 Use the Patch command, selecting the top edge of the
button and the ellipse or circle.

Patch

Look for this button.
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8 In the Patch optionsdialog box, set the point sampling small
enough to get a good join at the edge,

and uncheck the adjust tangency setting.

The size and vertical position of the circle/ellipse will affect
the shape of the surface.

9 Join the surfaces and use the FilletEdge command to soften the
edge.

A D V A N C E D S U R F A C I N G T E C H N I Q U E S

Notes:10 UndoPatchand repeat the command.

11 In the Patch optionsdialog box, check the adjust tangency
setting.

The surface is tangent to the edge and concave on the top.
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To use Rail Revolve to make the button:

A final method to make a button is to use a rail revolve.

1 Use the DupEdgecommand to duplicate the top edge of the
surface.

2 Movethe duplicated curve in the Z direction a small
amount.

3 Use the ExtractPtcommand on the curve.

4 Use the PlaneThroughPtcommand with the extracted points that
are already selected, then hide thepoints.

5 Use CplaneObjectto the plane.

A D V A N C E D S U R F A C I N G T E C H N I Q U E S

Notes:6 Draw a surface Normal (Curve > Line > Normal to
Surface) from the center of the plane (1) to use as

an axis.
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7 Draw a line (reference geometry) that is tangent to the edge
of the button surface (2).

8 Draw a curve that is perpendicular to the normal and tangent
to the edge (3) to use as a profile curve.

9 Use the RailRevolvecommand (Surface > Rail Revolve) with
Scaleoption. Select the profile curve,the top edge of the surface
(2) as the path curve, and the normal (3) as the axis for the
revolve.

Rail Revolve

Look for this button.

A D V A N C E D S U R F A C I N G T E C H N I Q U E S

Notes:10 Use the MatchSrf command (Surface > Edit Tools >
Match) to match the two surfaces to tangent

continuity.

Match Surface

Look for this button.
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Another option does not bother to make the profile curve
tangent. With this method you should filletthe edge to soften
it.

A D V A N C E D S U R F A C I N G T E C H N I Q U E S

Notes:

Creases

Often a surface needs to be built with a crease in it which
begins with an angle and diminishes to zeroangle at the other end.
The following exercise covers two possible situations.
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Exercise 13Surfaces with a crease

The key to following exercise is to get two surfaces that match
with different continuity at each end. At

one end we will match the surface with a 10 degree angle and at
the other end we will match thesurface with curvature continuity.
To accomplish this we will create a dummy surface at the
correctangles and use this to match the lower edge of the upper
surface.

1 Openthe Crease 01.3dmmodel.

2 Turn on the Curveand Loftlayers. Make the Loftlayer
current.

3 Use the Loftcommand to make a surface from the three curves
(1, 2, 3) on the Loftlayer.

We are going to make a surface that includes curves 1 and 3 but
has a crease along curve 2.

Loft

Look for this button.

A D V A N C E D S U R F A C I N G T E C H N I Q U E S

Notes:4 Use the middle curve (2) to Splitthe resulting surface
into two pieces.
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5 Use the ShrinkTrimmedSrfcommand (Surface > Edit Tools >
Shrink Trimmed Surface) on both

surfaces.The surfaces are now untrimmed.

6 Hide the lower surface.

To create the dummy surface:

We will change the top surface by matching it to a dummy surface
that we will create. The dummysurface will be made from one or more
line segments along the bottom edge of the top surface thatare set
at an angle from tangent to it. To get a line that is not tangent
but at a given angle fromtangent, two line segments are needed.
They are touching at their ends but are at an angle from each

other.

Shrink Trimmed Surface

Look for this button.

A D V A N C E D S U R F A C I N G T E C H N I Q U E S

Notes:1 Change to the Dummy Curvelayer.

2 In the Top viewport, use the Polylinecommand to make the first
segment 20 units long and parallel

to the x axis.
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3 Make the next segment 20 units long and at a 10 degree angle
from the x axis. The crease will have amaximum angle of 10
degrees.

4 From the Transformmenu, click Orient, then click Curve To
Edge.

5 At the Select curve to orientprompt, in the Front viewport,
select the left end of the polyline.

The orientation of the curve is relative to the construction
plane where the curve is picked.

The command uses the active construction plane, Z direction as
the reference for determining the

alignment of the curve to the surface normal on the target edge.
The end closest to the end picked willbe the end attached to the
edge.

6 At the Select target surface edgeprompt, select the bottom
edge of the surface.

7 At the Pick target edge pointprompt, snap to the endpoint
(1).

8 At the Pick target edge pointprompt, snap to the other
endpoint (2).

Orient Curve to Edge

Look for this button.

A D V A N C E D S U R F A C I N G T E C H N I Q U E S

Notes:9 At the Pick target edge pointprompt, press Enter.

The result should look like the image above. If the result looks
different (the curve angles the wrong

way), flip the surface normals on the target surface.

The upper segment of polyline is tangent to the surface, and the
lower segment is at 10 degrees from

tangent.10 E plode the pol lines
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10 Explodethe polylines.

11 Move the 10 degree segment of the polyline at the left side
of the surface by its upper end (1) tocoincide with the upper end
(2) of the tangent segment.

12 Delete the tangent segment on the left.

13 Delete the 10 degree segment of the polyline at the right
side of the surface.

14 Make the Dummy Surface layer current.

15 Use the Sweep1command (Surface > Edit Tools > Sweep 1
Rail) to create the dummy surface.

Sweep 1 Rail

Look for this button.

A D V A N C E D S U R F A C I N G T E C H N I Q U E S

Notes:16 Select the lower edge (1) of the upper surface as the
rail and the two line segments (2 & 3) as cross-

section curves.

Make sure to use the surface edge and not the original input
curve as the rail for the sweep.
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17 In the Sweep 1 Rail Optionsdialog box, choose Follow Edge
from the Stylelist.

This option causes the cross-section curves to maintain their
orientation relative to the surface edge. A

tangent curve (2) will be swept along the edge holding tangency
all along unless another shape curve(3) with a different
orientation is encountered, in which case there will be a smooth
transition fromone to the next.

1 Use the MatchSrfcommand (Surface > Edit Tools > Match)
to match the upper surface to the dummy

surface.

A D V A N C E D S U R F A C I N G T E C H N I Q U E S

Notes:2 At the Select surface to change - select near
edgeprompt, select the lower edge of the upper

surface.
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3 At the Select target surface - select near edgeprompt, select
the upper edge of the dummysurface.

4 In the Match Surfacedialog box, choose Tangencyand check Match
edges by closest point.

This will keep distortion to a minimum.

5 Show the lower (red) surface and hide the (blue) dummy
surface.

6 Jointhe lower surface with the upper surface.

A D V A N C E D S U R F A C I N G T E C H N I Q U E S

Notes:7 Shade the model.

The crease fades smoothly from one end to the other of the
polysurface. If more control is needed

over the angles of the crease, more segments can be placed to
create the dummy surface.
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Because the surfaces are untrimmed, you have the option to merge
the surfaces back into onesurface.

8 Undothe previous join operation.

9 From the Surfacemenu, click EditTools, then click Merge.

10 At the Select surface near untrimmed edge to merge (Tolerance
Smooth=Yes Roundness)prompt, type S and press enter.

This will keep the crease.11 At the Select surface near
untrimmed edge to merge (Tolerance Smooth=No Roundness)

prompt, select one of the common edges.

A D V A N C E D S U R F A C I N G T E C H N I Q U E S

Notes:12 At the Select surface near untrimmed edge to merge
(Tolerance Smooth=No Roundness)

prompt, select the other common edge.

The surface is merged into one surface, but the crease is still
visible.
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Exercise 14Surfaces with a crease (Part 2)

In this exercise there is no convenient relationship between the
crease curve and the surface. While

similar to the other example, the upper surface is made with a
two rail sweep.

To create a crease with trimmed surfaces:

1 Openthe Crease 02.3dmmodel.

2 Use the OrientCrfToEdgecommand (Transform > Orient >
Curve to Edge) to move the curve for the

dummy surface to the upper edge of the lower surface.

3 Place a curve at each end of the edge and somewhere in the
middle of the edge.

If the curve flips over at either end, place it as close to
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